# Table of Contents

1  **Introduction** .......................................................................................................................... 3  
   1.1  Where to find help .................................................................................................................. 3

2  **Installation** .............................................................................................................................. 5
   2.1  System Requirements .............................................................................................................. 5
   2.2  License options ....................................................................................................................... 5
   2.3  Running the CES EduPack 2017 setup wizard ..................................................................... 6

3  **Databases** ................................................................................................................................ 7
   3.1  Databases for Rational Materials Selection .......................................................................... 7

4  **Getting Started with CES EduPack** ......................................................................................... 9
   4.1  Main tools in CES EduPack ..................................................................................................... 9
   4.2  Browsing and Searching ......................................................................................................... 10
   4.3  Creating property charts ......................................................................................................... 15
   4.4  Filtering and Screening ............................................................................................................ 18
   4.5  Putting it all together ............................................................................................................... 22
   4.6  Process Selection .................................................................................................................... 23
   4.7  Eco Audit Tool ......................................................................................................................... 24
   4.8  Synthesizer Tool .................................................................................................................... 28
   4.9  Saving, Copying, and Report Writing ..................................................................................... 32

5  **Toolbars and general information** .......................................................................................... 34
   5.1  Standard toolbar ..................................................................................................................... 34
   5.2  Chart Stage toolbar ................................................................................................................ 34
   5.3  CES EduPack file types .......................................................................................................... 34
   5.4  Options for Preferred Currency and Units ............................................................................ 35
   5.5  Physical Constants and Conversion of Units ....................................................................... 36

6  **Legal, acknowledgements, and contact information** ............................................................... 38
1 Introduction

CES EduPack supports and enhances the teaching and learning of engineering, materials, design, and sustainability. It provides a comprehensive database of materials and process information, powerful materials software tools, and a range of supporting textbooks, lectures, projects, and exercises.

CES EduPack is a curriculum-wide resource with specialist editions for specific disciplines, and three levels of the database and software to suit varying needs in all years of undergraduate study and postgraduate teaching. It is continually developed based on feedback from the global user community.

The CES EduPack software provides engaging ways for students to explore and understand the world of materials:

- **Become familiar with materials space**—with powerful tools to browse and search the information in CES EduPack databases.
- **Visualize properties**—charting tools help to develop understanding of how material families behave.
- **Match materials to applications**—for example, by applying a structured approach to materials selection; helps students to relate their learning to the world around them.
- **Dig into the underlying science**—encourage students to get to grips with the scientific principles through textbook-style 'science note' information and textbook links.
- **Evaluate environmental impact with the Eco Audit Tool**—explore key eco design concepts; try 'what if' scenarios.
- **Additional tools** are also available, such as the innovative Synthesizer Tool that allows investigation into the benefits of using hybrid materials, and estimates the part cost using material and processing specifications.

1.1 Where to find help

You will be surprised at all the additional help and resources that can be accessed from CES EduPack.

Getting Started

The [Installation Guide](#) is the starting point for anyone that has not yet installed CES EduPack.

If you have any questions or issues at this stage, you can refer to our [Student FAQs](#).

Or the [Educator FAQs](#).
Learning How CES EduPack Works

This User Manual and Getting Started Guide, as well as the Video Tutorials, are the best way to learn about the core functionality of the software.

The In-Software Help is accessed from the Help menu, or by pressing F1. As well as explaining the core functionality, it also includes useful references like the Tables of Materials Indices and glossaries of materials terms.

Further Learning

The Learn page, accessible from the main toolbar, provides learning resources for students to support self-study. Further resources are provided in Learn Online.

The Case Studies were created by Professor Mike Ashby and follow the material selection methodology outlined in his book, Materials Selection in Mechanical Design. They can be completed using CES EduPack.

Granta’s Education Hub provides teaching and learning resources, including videos, case studies, and extra databases. You can join using your institutional email address.
2 Installation

This part of the User Manual provides instructions for installing your copy of CES EduPack.

2.1 System Requirements

To install CES EduPack 2017 you will need:

- A compatible Microsoft® Windows® operating system:
  - Windows 7 32-bit or 64-bit,
  - Windows 8 32-bit or 64-bit,
  - Windows 10 32-bit or 64-bit.
- 2 GB of RAM (more is recommended when using large databases).
- 3.5 GB of available hard disk space.
- Microsoft .NET Framework version 4.5.1, Microsoft Report Viewer 2010 SP1, and Microsoft Visual C++ Redistributable Packages for Visual Studio. If any of these are not installed, they will be installed during the CES EduPack installation. For the French language installation, you will also require the French language packs for these.
- Administrator rights.
- Internet access, if you wish to use the web-based search, the online resources, or connect to datasheets from external databases, where applicable.

2.2 License options

Students

If you are a student installing this on your own computer, you should have been given the files to install CES EduPack 2017, including the file licence.xml. This should be in the same folder as the installer.

For the Student FAQ page, please go to: www.grantadesign.com/education/support/FAQs/students.htm

Educators and IT admins

Enrollment licenses are licenses for a group of students for a limited period of time. Lab licenses are perpetual licenses for a fixed number of computers.

The license key is connected with your, or your institution’s, My Granta account. You need the My Granta account log in information to download and install the software.

For the Educators FAQ page, please go to: www.grantadesign.com/education/support/FAQs/educators.htm

For the IT admin FAQ page, please go to: www.grantadesign.com/education/support/FAQs/network.htm
2.3 Running the CES EduPack 2017 setup wizard

If you have installed a previous version or an evaluation copy of CES EduPack, we recommend that you uninstall it before installing this version. To do so, use Programs and Features in Windows Control Panel to uninstall the software.


Installation for students

To install CES EduPack 2017:

1. Copy the files onto your computer. Make sure licence.xml is in the same folder as the installer, edupack_setup.XXXX.exe.
2. Run the installer and follow the on-screen instructions.

For the Student FAQ page, go to www.grantadesign.com/education/support/FAQs/students.htm.

Installation for educators and IT admins

To install CES EduPack 2017:

1. Go to Granta’s Education Hub and sign in to your My Granta account teachingresources.grantadesign.com/MyGranta-Account.
2. Click Download software, and click the download link to save the installer (edupack_setup.XXXX.exe).
3. Run the installer. Enter your My Granta account information when prompted.
4. To install the software locally, click Install now, and follow the on-screen instructions.

Distribution for educators and IT admins

Depending on your CES EduPack license, you may have a license for more than one edition of CES EduPack. You can use the CES EduPack 2017 installer to create a custom offline installer to distribute to students and colleagues. This will allow them to install a specific CES EduPack edition:

1. Go to Granta’s Education Hub and sign in to your My Granta account teachingresources.grantadesign.com/MyGranta-Account.
2. Click Download software, and click the download link to save the installer (edupack_setup.XXXX.exe).
3. Run the installer. Enter your My Granta account information when prompted.
4. Click Create installation package.
5. Select the edition you want to distribute.
6. Click Continue. This will create an installer in a folder that you can then distribute to other licensed users. They do not need to log in to My Granta to install CES EduPack.

For the FAQ page, go to www.grantadesign.com/education/support/FAQs.htm.
3 Databases

Different databases are available depending on your installation.

The databases are split into Introductory – Level 1 and 2 databases – and Advanced – Level 3 databases – with different editions to cover specific areas of study e.g. Aerospace and Sustainability.

There are video Database Tours, to give you more information on the different levels and databases: www.grantadesign.com/education/resources/videotutorials/2017/index.htm.

3.1 Databases for Rational Materials Selection

The MaterialUniverse and ProcessUniverse data modules are used with CES EduPack to create high quality databases that you won’t find elsewhere. They are designed for like-to-like comparisons across the whole spectrum of material and processing possibilities. Typical material databases do not allow this – the most common reasons being: ‘holes in the data’ and different properties reported for different materials, making it difficult to compare different classes of materials.

The Universe data modules solve these problems by conforming to strict database design principles. These principles are reviewed below, with reference to the MaterialUniverse data module.

Complete spectrum represented

MaterialUniverse contains a representation of virtually every commercial engineering material in every class. This means that you can be sure that you have considered all possible materials for any particular application.

Each material represented only once

Multiple instances of the same material from different producers are consolidated into one representative record. This reduces the complexity of your search for the best material.

Property ranges

Properties of real materials are seldom exact – there are inevitable variations from batch to batch and manufacturer to manufacturer. These variations are captured in the Universe data modules by a range, which may be small for a property such as density, but relatively large for price or toughness.

Complete property set

In a Universe data module, there is a value for every property on the datasheet. If the value is not known experimentally, it has been estimated by using intelligent estimating techniques based on well-established correlations between material properties, using fundamental physics.

Quality checks

Granta has examined hundreds of datasets over the years from various sources, and most contain errors, sometimes by as much as 1000%! To minimize errors in the Universe data modules, strict data checking procedures are used. These include checks that properties for specific material classes fall within acceptable ranges, and powerful science-based checks on the correlations between properties.
Normalization

All properties are presented in the same unit system, which you can change in the CES EduPack settings. Properties that are reported in different ways for different materials classes are equivalenced to enable comparison.

Hierarchy

The carefully-constructed record hierarchy allows simple and rapid navigation to all records in the data module.

References

The reference source is given at the bottom of the datasheet, to encourage students to question and research where the data comes from.
4 Getting Started with CES EduPack

The exercises in this section give an overview of CES EduPack and will teach you how to use the core functionality. There is a comprehensive help file within the software that provides further guidance, as well as containing case studies and tutorials.

4.1 Main tools in CES EduPack

The main tools in CES EduPack are:

- **BROWSE**
  Explore the database and retrieve records via a hierarchical index or tree.

- **SEARCH**
  Find information via a full-text search of records.

- **SELECT**
  The central hub of CES EduPack, used to apply the Rational Material Selection methodology. A powerful selection engine that identifies records that meet an array of design criteria and enables trade-offs between competing objectives.

- **CHART**
  Create charts and add formatting and labels to illustrate your point.

- **ECO AUDIT**
  Quickly estimate the environmental impact of a product over its entire lifecycle and study *What If* design scenarios. The enhanced version also accounts for Secondary, Joining, and Finishing processes, and allows you to apply the same *What If* scenarios to the economic cost.

- **SYNTHESIZER TOOL**
  Predict performance of materials by modelling new hybrid materials, or modelling part cost of a design; and compare these results with existing records.

The following exercises cover the use and functionality of these tools.
4.2 Browsing and Searching

Exercise 1 — Opening a Database

On starting CES EduPack, the Databases window will appear, showing all installed databases. The following exercises use the MaterialUniverse and ProcessUniverse tables which are found within all Granta material databases. After clicking on a database name in the Databases window to select it, the Homepage then opens to show a list of the available tables and a graphic for each subset.

Level 2

<table>
<thead>
<tr>
<th>1. Select a table</th>
<th>2. Filter by subset</th>
<th>Subset selected</th>
</tr>
</thead>
<tbody>
<tr>
<td>MaterialUniverse</td>
<td></td>
<td>All Materials</td>
</tr>
<tr>
<td>ProcessUniverse</td>
<td></td>
<td>Composites</td>
</tr>
<tr>
<td>Reference</td>
<td></td>
<td>Metals and Alloys</td>
</tr>
<tr>
<td>Producers</td>
<td></td>
<td>Foams</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Elastomers</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Glasses</td>
</tr>
</tbody>
</table>

Click a subset name to show its description. Use the information icon next to the database name to view a detailed description. There are also links to online resources, for both students and educators, from the home page.

❖ Select Level 2 database

Note: Unless otherwise stated, all exercises and screenshots in this guide were produced using Level 2 database. Results and images may differ if you complete these exercises using a different database.

❖ Select different subsets and read about the available data and applications

Click a subset in the Homepage to select it. The information displayed is for the currently-selected subset.

❖ Change to the PROCESSUNIVERSE table

Click ProcessUniverse and notice that the Browse tree in the left panel updates.
❖ Close the HOMEPAGE

Click the cross at the top of the Homepage tab. This page can be reopened at any time by clicking Home on the main toolbar.

❖ Change to the MATERIALUNIVERSE table

With the Homepage closed, navigate to different tables using the Table list in the Browse window.

---

Exercise 2 — Browse Material Records

❖ Select the MATERIALUNIVERSE table and the ALL MATERIALS subset

---

❖ Find the record for STAINLESS STEEL

Double-click a folder in the browse tree to view the records and folders below it.

❖ Open the FOLDER-LEVEL record for POLYMERS

Folder-level records provide a general overview of a material family, rather than containing data on a specific material. They have their own icon:

❖ Open the POLYPROPYLENE record

Double-click the record name in the tree to view the datasheet.

Click hyperlinked attribute names on the datasheet. In Level 1 and Level 2 databases, this will bring up a Science Note, giving details of the underlying science and calculations for the attribute. In Level 3 databases, this will bring up the design note, which provides background information on properties, test notes, and selection guidelines. From a design note, there will be a link to the corresponding Science Note.
Right-click the datasheet to see a menu with further actions, for example, locate in Browse tree, copy the datasheet, print the datasheet, and export the data to an FE package format.

❖ Find processes that can shape POLYPROPYLENE, by clicking the ProcessUniverse link at the bottom of the datasheet.

Part of the Polypropylene Level 2 datasheet:

Polymers and elastomers > Polymers > Thermoplastics >

**Description**

**Image**

![Polypropylene samples showing texture and transparency](image1.png) ![Polypropylene glasses](image2.png)

**Caption**

1. Polypropylene samples showing texture and transparency. © Chris Little 2. Polypropylene glasses. © Thinkstock

**The material**

Polypropylene, PP, first produced commercially in 1958, is the younger brother of polyethylene - a very similar molecule with similar price, processing methods and application. Like PE it is produced in very large quantities (more than 30 million tons per year in 2000), growing at nearly 10% per year, and like PE its molecule-lengths and side-branches can be tailored by clever catalysis, giving precise control of impact strength, and of the properties that influence molding and drawing. In its pure form polypropylene is flammable and degrades in sunlight. Fire retardants make it slow to burn and stabilizers give it extreme stability, both to UV radiation and to fresh and salt water and most aqueous solutions.

**Composition (summary)**

(CH2-CH(CH3))n

**General properties**

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Density</td>
<td>890 kg/m³</td>
</tr>
<tr>
<td>Price</td>
<td>*1.7 USD/kg</td>
</tr>
<tr>
<td>Date first used</td>
<td>1957</td>
</tr>
</tbody>
</table>

**Mechanical properties**

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Young's modulus</td>
<td>0.896 GPa</td>
</tr>
<tr>
<td>Shear modulus</td>
<td>0.316 GPa</td>
</tr>
<tr>
<td>Bulk modulus</td>
<td>2.5 GPa</td>
</tr>
<tr>
<td>Poisson's ratio</td>
<td>0.406</td>
</tr>
</tbody>
</table>

For more information on the property and to drill down to the underlying science, click to view the science note.
Exercise 3 — Browse Process Records

- **Browse ProcessUniverse: All Processes**

  - **Table:** ProcessUniverse
  - **Subset:** All processes

- **Find the record for INJECTION MOLDING, THERMOPLASTICS**

- **Find the record for VAPOR METALLIZING (PVD)**

- **Find the record for FRICTION WELDING (METALS)**

- **Find materials that can be DIE CAST, using the link to the MaterialUniverse at the bottom of the datasheet for DIE CASTING**
Exercise 4 — Searching

❖ Find the material POLYLACTIDE

Browse  Search  Select

[Polyactide]

❖ Find the materials used as CUTTING TOOLS

❖ Find the process VACUUM ASSISTED RTM

❖ Find the material CONCRETE

The folder name is also included in the search. If the term appears in a folder name, all records under that folder will be returned; for example, a search for concrete would return all records in the folder named Cement and concrete e.g. Plaster of Paris.

❖ Enter the search term ALUM*

Records containing the term Alumina or Aluminum or Alumino are returned.

Advanced searches

The following search operators are available:

AND  Finds records containing both the search terms, so steel AND alloy returns only records containing both the words steel and alloy

OR  Finds records containing either search term, so steel OR alloy returns all records that contain steel, alloy, or both

NOT  Finds records containing the first search term, but not the second, so steel NOT alloy returns only records with the word steel but without the word alloy

Phrase Search  Finds the exact search term, so “steel alloy” will return only records containing the exact phrase steel alloy

Parentheses  Used to group search terms, so iron AND (ore OR cast) will return the records containing iron and containing either ore, cast, or both

Wildcards  Use ? as a wildcard single character, or * as a wildcard representing any number of characters (cannot be used as the first character in a search string)

Note: AND operators are automatically added when a search has two or more terms and no other operators have been entered.
Exercise 5 — Find Supporting Information

You will need an internet connection for this exercise.

CES EduPack translates the material ID into search strings compatible with a group of high-quality material and process information sources, and delivers the search results. Many of the sources require a subscriber-based password. The ASM source is particularly recommended.

❖ Search the web to find more information on PET

With the PET datasheet open, click Tools > Search Web.

4.3 Creating property charts

Bar charts and bubble charts are a great way to visualize and communicate material properties, as well as being a key tool to support systematic materials selection.

Exercise 6 — Create a bar chart

❖ Select MATERIALUNIVERSE: ALL MATERIALS

Click Chart/Select, and then select MaterialUniverse: All materials.

❖ Make a bar chart of YOUNG’S MODULUS (E)

Under Selection Stages, click Chart.

Set the y-axis attribute to Young's modulus, then click OK.

For a bar chart, you do not set an x-axis: leave x-axis set to <None>.

❖ Explore the chart

Click Zoom in and then drag to zoom in on an area of the chart.

Click Zoom out to zoom out.

Click Autoscale to zoom back to view the whole chart again.

❖ Label records on the chart

Click a record in the chart and then drag to add and position a new data label.
To delete a data label, select it, and press DELETE. To delete all labels in the chart, press CTRL+A and then press DELETE.

Exercise 7 — Create a bubble chart

❖ Make a bubble chart plotting YOUNG'S MODULUS (E) against DENSITY (ρ)

Under Selection Stages, click Chart.
Set the y-axis to Young's modulus and set the x-axis to Density.
Leave the Axis Settings as default values to create a log-log plot.

❖ Display family envelopes

Click to look at how data for a given family of materials cluster together.
Label records on the chart

Hover the cursor over the record bubble to see the record name, and then label some records (click over a record and drag).

Try adding labels from the Results list: select a record in the list, right-click and select Label on the shortcut menu, then drag the label where you want it on the chart.

If the new label isn’t visible at the current zoom, click Autoscale to display the whole chart again.

Delete this stage

Select the stage in the Selection Stages list and press DELETE.
4.4 Filtering and Screening

Exercise 8 — Selection Using a Chart Stage

When plotted on a Chart Stage, records can also be filtered using the Index line and Box selection tools. This provides a more qualitative approach to filtering.

1. Selection Data
   Select from: Material Universe: All materials

2. Selection Stages
   Chart Tree Limit Search

3. Results
   X out of Y pass

❖ Make a Bar Chart of YIELD STRENGTH (σ_y)
   Set the y-axis to Yield strength (elastic limit).

❖ Use a Box selection to identify materials with high values of YIELD STRENGTH
   Click Box selection, then drag to define the selection box.
❖ **Add DENSITY (ρ) to the x-axis**

Click Chart Settings then click the X-Axis tab and select **Density** as the axis attribute.

❖ **Use an INDEX LINE to identify materials with high values of the specific strength σᵧ / ρ**

Click **Index and display lines**

Use the default **Slope** value of 1.

The objective of the line is set to **Maximize the index** by default, which will result in selection of materials above the line, for high values of σᵧ / ρ.

Click **OK** and then click the chart to position the line through a particular point.

Drag the line upwards to refine the selection to fewer materials.

❖ **Add a Box selection to the chart to identify materials with low DENSITY that maximize the index.**

❖ **Rank the results by specific strength (YIELD STRENGTH / DENSITY)**

**Show:** Stage 1: Yield strength v. Density

**Rank by:** Stage 1: Index value.

Example results: Bamboo, Paper, Foam.

❖ **Delete this stage**

Select the stage in the Selection Stages list and press **DELETE.**
Exercise 9 — Selection Using a Limit Stage

1. Selection Data
   Select from: MaterialUniverse: All materials

2. Selection Stages
   Chart Limit Tree

3. Results
   X out of Y pass

Limit Stage
   ▶ Impact & fracture properties
   ▼ Thermal properties
   Max. service temp. Min 200 °C Max
   Thermal conductivity Min 25 W/m.°C Max
   ▼ Electrical properties
   Electrical resistivity Min 1e15 μohm.cm Max

❖ Select materials with specific thermal and electrical properties.
   Create a new Limit Stage with the following criteria:
   MAX. SERVICE TEMPERATURE > 200 °C
   THERMAL CONDUCTIVITY > 25 W/m.°C
   ELECTRICAL RESISTIVITY > 1e15 μohm.cm
   Example results: Aluminum nitride, Alumina, Silicon nitride.
   Use the limit bars for guidance on suitable values. Enter the limits – minimum or maximum as appropriate – and click Apply.
   You can change the units on the datasheet by clicking the Units tab under Tools > Settings.

❖ Filter the results further to select only materials with non-opaque TRANSPARENCY.
   Under Optical Properties, in the Transparency list, select Translucent, Transparent, and Optical quality.
   Click Apply.
   Example results: Alumina and Silicon Nitride.

❖ Delete this stage.
Exercise 10 — Selection Using a Tree Stage

Using a Tree Selection Stage, you can filter records based on their links to records in other data tables, or based on the database hierarchy (tree).

1. Selection Data
   Select from: MaterialUniverse: All materials

2. Selection Stages
   - Chart
   - Limit
   - Tree

3. Results  $X$ out of $Y$ pass

❖ Find materials that can be MOLDED
   Under Selection Stages, click Tree. In the Tree Stage window, select ProcessUniverse, navigate to Molding, and click Insert, then click OK.

❖ Click Show to see a list of the materials in MaterialUniverse to which this process is linked.

❖ Delete this stage.

❖ Find processes to join FERROUS METALS AND ALLOYS
   In the Selection Project pane, under Selection Data, select ProcessUniverse: Joining.

   Under Selection Stages, click Tree. Select MaterialUniverse, expand Metals and alloys, select Ferrous, and then click Insert followed by OK.

❖ Delete this stage.
4.5 Putting it all together

Exercise 11 — Combining Filtering and Charting Tools

1. Selection Data
Select from: MaterialUniverse: All materials

2. Selection Stages

3. Results
X out of Y pass; ranked by PRICE

❖ Choose the data source.
Select from: MaterialUniverse: All materials.

❖ Select materials with specific physical, mechanical, and thermal properties.
Add a Limit Stage with the following criteria:
DENSITY < 2000 kg/m^3
YIELD STRENGTH (Elastic limit) > 60 MPa
THERMAL CONDUCTIVITY < 10 W/m.°C

❖ Filter the results to find those that can be THERMOFORMED
Add a Tree Stage and select ProcessUniverse > Shaping > Molding > Thermoplastic molding > Thermoforming.

❖ Rank the results by PRICE and find the three cheapest materials
Add a Chart Stage with a bar chart of Price. On the Chart Stage, all materials that fail one or more stages are grayed out. The Results window by default lists the materials that pass all stages.
In the Rank by list, select Stage 3: Price.
4.6 Process Selection

Exercise 12 — Selecting Processes

1. Selection Data
Select from: ProcessUniverse: Shaping

2. Selection Stages
Chart Limit Tree

Choose the data source
Select from: ProcessUniverse: Shaping.

Find PRIMARY SHAPING PROCESSES to make a component with specific shape, physical, and economic properties.

Add a Limit Stage with five criteria:
- SHAPE
- MASS
- SECTION THICKNESS
- PROCESS CHARACTERISTICS
- ECONOMIC BATCH SIZE

Filter the results to only include THERMOPLASTIC materials
Add a Tree Stage and select MaterialUniverse > Polymers and Elastomers > Polymers > Thermoplastics.
Example results: Rotational molding, Compression molding, Thermoforming.
4.7 Eco Audit Tool


The Eco Audit Tool estimates the energy used and CO₂ produced during five key life phases of a product (material, manufacture, transport, use, and end of life), and identifies which phase has the dominant contribution. This is the starting point for eco-aware product design, as it identifies which parameters need to be targeted to reduce the eco-footprint of the product.

A brand of bottled mineral water is sold in 1 liter PET bottles with polypropylene caps. A bottle weighs 40 grams; the cap 1 gram. Bottles and caps are molded, filled, and transported 550 km from the French Alps to England by 14 tonne truck, refrigerated for 2 days and then sold. The overall life of the bottle is one year.

An example product file for this case study is installed with CES EduPack in the Samples folder, with the filename Bottle PET - Level 2.prd.

Product Definition

The following example shows how the example product file has been created.

For an explanation of the calculations used at each stage, click Help in the heading.

1. Material, manufacture, and end of life

Bill of materials (BoM) and primary processing method.

<table>
<thead>
<tr>
<th>Qty</th>
<th>Component name</th>
<th>Material</th>
<th>Recycled content</th>
<th>Mass (kg)</th>
<th>Primary process</th>
<th>End of life</th>
</tr>
</thead>
<tbody>
<tr>
<td>100</td>
<td>Bottle</td>
<td>PET</td>
<td>Virgin (0%)</td>
<td>0.04</td>
<td>Polymer molding</td>
<td>Recycle</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Landfill</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Combust</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Downcycle</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Re-manufacture</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Reuse</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>None</td>
</tr>
<tr>
<td>100</td>
<td>Cap</td>
<td>PP</td>
<td>Virgin (0%)</td>
<td>0.001</td>
<td>Polymer molding</td>
<td>Recycle</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Landfill</td>
</tr>
<tr>
<td>100</td>
<td>Dead weight</td>
<td></td>
<td></td>
<td>1</td>
<td></td>
<td>None</td>
</tr>
</tbody>
</table>

2. Transport

Transportation from site of manufacture to point of sale.

<table>
<thead>
<tr>
<th>Name</th>
<th>Transport type</th>
<th>Distance (km)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Filling plant to retailer</td>
<td>14 tonne truck</td>
<td>550</td>
</tr>
</tbody>
</table>

Sea freight
Rail freight
14 tonne truck
Air freight – long haul
3. Use

**Product Life and Location Use**

Product life: 1 years
Country of use: United Kingdom

**Static Mode**

Energy used to refrigerate product at point of sale (average energy required to refrigerate 100 bottles at 4°C = 0.12kW).

Product uses the following energy:

Energy input and output: Electric to mechanical (electric motors)
Power rating: 0.12 kW
Usage: 2 days per year
Usage: 24 hours per day

4. Report

**Summary chart** enables rapid identification of the dominant life phase. Toggle between views of energy usage or CO₂ footprint.

The chart shows that, in this project, Material is the dominant life phase. Each life phase can be clicked to show guidance on strategies to reduce its impact.

**Detailed report** provides a component-by-component breakdown of each life phase, enabling the main contributors to the dominant life phase to be identified.
Exercise 13 — Compare Eco Audit Projects

❖ Open the Bottle PET - Level 2 product file.

Click Open and locate the sample product file Bottle PET - Level 2.prd, located in the Samples folder in your CES EduPack installation folder. For example:
C:\Program files (x86)\CES EduPack 2017\Samples\eco_audit\en\Bottle PET - Level 2.prd

❖ Create a copy of this product for comparison

Click Compare with and select Copy of current product.

❖ Set the following values in for the new product:

<table>
<thead>
<tr>
<th>NAME</th>
<th>PET Bottle (Recycled)</th>
</tr>
</thead>
<tbody>
<tr>
<td>RECYCLED CONTENT</td>
<td>35%</td>
</tr>
</tbody>
</table>

❖ Generate the SUMMARY CHART

The first life energy (not including EoL potential) is reduced by 15%.

Note: The chart can be copied into a document or printed using Copy and Print at the top of the chart window.

Exercise 14 — Saving and Exporting

Eco Audit projects do not form part of a selection project and therefore need to be saved separately.
❖ SAVE the product definition

❖ GENERATE the Eco Audit report

Click the Report tab (or click Detailed Report on the Product definition tab).

❖ EXPORT the report as a PDF

You will require a PDF reader such as Adobe Reader to view the exported report.

Note: The Level 3 Eco Design and Level 3 Sustainability databases contain an enhanced version of the Eco Audit tool, which contains warnings about restricted substances, and options to include cost analysis and a secondary process in the audit. Please read the in-software help, or the online teaching resources for information on how to get started with these advanced features.
4.8 Synthesizer Tool

The Synthesizer Tool is only available in some advanced editions of CES EduPack.

The Synthesizer Tool is designed for use in the early stage of product development. It consists of two types of models: hybrid models, for estimating the performance of novel materials and structures; and the part cost estimator, for calculating the cost of a component based on the material and process chain.

Synthesized records produced using the Synthesizer Tool can then be compared with existing records in the MaterialUniverse database using selection stages.

Exercise 15 — Hybrid Model: Sandwich Panels Model

Hybrid materials and structures combine the benefits of two or more materials to produce new materials that exhibit unique combinations of properties. For example, both composite materials and sandwich panels are commonly used to create strong, lightweight structures.

Note: You will need to use a Level 3 database for this exercise.

❖ Make a BUBBLE CHART of YOUNG’S MODULUS (E) against DENSITY (p) using MaterialUniverse: All bulk materials

As in Exercise 7.

❖ Use the SANDWICH PANELS MODEL to create synthesized records for a family of hybrid materials

Click Synthesizer on the toolbar (or click Tools > Synthesizer on the menu bar). Select the Sandwich Panels – Balanced model.

❖ Set the SOURCE RECORD values

| FACE-SHEET | Aluminum, 6061, wrought, T6 |
| CORE       | Polymethacrylimide foam (rigid, 0.200) |

Click Browse and locate the records in the browse tree.

❖ Leave the default values for MODEL VARIABLES and MODEL PARAMETERS, and set the following RECORD NAMING values:

| FACE-SHEET | Al |
| CORE       | Rohacell |

❖ CREATE the synthesized records

Click Create and then Finish. The new synthesized records will be shown in the Results list and on the Chart Stage.

Note: Click the help icon in the Synthesizer Tool dialog to view further information about the current model type, including details of the calculations used.

❖ Plot an INDEX LINE corresponding to a lightweight, stiff panel in bending \( E^{1/3}/p \)

Click Index and display lines, enter a slope of 3, and select maximize the index.
Add labels to the source records and some of the synthesized records

You can select individual records on the chart and drag to place a label.
You can also add labels from the Results list: select one or more records in the Results list, right-click and select Label on the shortcut menu, then then drag the labels where you want them on the chart.

Click Highlight synthesized records to help you identify the synthesized records on the chart.
Use the Zoom controls to zoom in to the area of interest on the chart.

Synthesized records appear on the Browse tree under My Records and may be edited or deleted in a similar way to User Defined records.
Exercise 16 — Part Cost Estimator

The Part Cost Estimator is a synthesizer model that calculates the total cost of a component based on the material and processing costs.

❖ Use the Part Cost Estimator to compare the cost a component manufactured in two different ways: as an injection molded polymer, and as a rolled and pressed metal.

Start Synthesizer Tool by clicking Synthesizer on the toolbar and in the dialog, select Cost – Part cost estimator.

❖ Set the COMPONENT DETAILS:

<table>
<thead>
<tr>
<th>MATERIAL</th>
<th>PP (copolymer, 20% talc)</th>
</tr>
</thead>
<tbody>
<tr>
<td>VALUE OF SCRAP MATERIAL</td>
<td>10%</td>
</tr>
<tr>
<td>PART MASS</td>
<td>6.4</td>
</tr>
<tr>
<td>PART LENGTH</td>
<td>10</td>
</tr>
<tr>
<td>BATCH SIZE</td>
<td>1000 - 1E6</td>
</tr>
<tr>
<td>NUMBER OF VALUES</td>
<td>10</td>
</tr>
</tbody>
</table>

Note: for this exercise, the units of part mass and part length do not matter.

❖ Set the PRIMARY SHAPING PROCESS values:

<table>
<thead>
<tr>
<th>PRIMARY PROCESS</th>
<th>Injection molding (thermoplastics)</th>
</tr>
</thead>
<tbody>
<tr>
<td>AVAILABILITY</td>
<td>Custom form</td>
</tr>
<tr>
<td>PART COMPLEXITY</td>
<td>Standard</td>
</tr>
</tbody>
</table>

Use the default values for load factor, overhead rate, and capital write-off time.

❖ Set the RECORD NAMING values:

<table>
<thead>
<tr>
<th>MATERIAL</th>
<th>PP</th>
</tr>
</thead>
<tbody>
<tr>
<td>PRIMARY PROCESS</td>
<td>molded</td>
</tr>
</tbody>
</table>

❖ Create the new records.

Click Create. Keep the Part Cost Estimator window open.

The new synthesized records will be shown in the Results list and on the Chart Stage.

❖ Add another material process.

In the Part Cost Estimator window, click Previous and set the COMPONENT DETAILS for another material process:

<table>
<thead>
<tr>
<th>MATERIAL</th>
<th>YS170 (hot rolled) high strength steel</th>
</tr>
</thead>
<tbody>
<tr>
<td>PART MASS</td>
<td>10</td>
</tr>
</tbody>
</table>

Use the default values for scrap material value, part length, batch size, and number of values (retained from the first material processing chain input).

❖ Set the PRIMARY SHAPING PROCESS values:

<table>
<thead>
<tr>
<th>PRIMARY PROCESS</th>
<th>Hot shape rolling</th>
</tr>
</thead>
</table>

Use the default values for the other properties.
❖ Set the SECONDARY SHAPING PROCESS.

Select include secondary process, and enter the following values:
SECONDARY PROCESS: Press forming
Use the default values for part complexity, amount of scrap, and scrap recycled.

❖ Set the RECORD NAMING values:

<table>
<thead>
<tr>
<th>MATERIAL</th>
<th>Steel</th>
</tr>
</thead>
<tbody>
<tr>
<td>PRIMARY PROCESS</td>
<td>rolled</td>
</tr>
<tr>
<td>SECONDARY PROCESS</td>
<td>pressed</td>
</tr>
</tbody>
</table>

❖ Click Create and then Finish to create the synthesized records and close the Part Cost Estimator.

Synthesized records created using Part Cost Estimator are appended to the MaterialUniverse tree under My records > Synthesized > Part cost estimator.

❖ Create a bubble chart to compare the two material processing chains.

Click Chart/Index and set the following x- and y-axis values:

<table>
<thead>
<tr>
<th>CATEGORY</th>
<th>Part cost estimator</th>
</tr>
</thead>
<tbody>
<tr>
<td>X-AXIS ATTRIBUTE</td>
<td>Batch size</td>
</tr>
<tr>
<td>Y-AXIS ATTRIBUTE</td>
<td>Part cost</td>
</tr>
</tbody>
</table>

❖ Change the record color for easy comparison of the two processing chains.

On the MaterialUniverse tree, navigate to My records > Synthesized > Part cost estimator.

Right-click the PP, molded subfolder, click Record color, and click a color to change the record color for all records in that folder.
4.9 Saving, Copying, and Report Writing

Exercise 17 — Adding Comments and Saving a Project

You can add comments to a selection project as a reminder of why you have applied certain constraints and objectives. Comments are displayed on mouse-over in the selection report, and are saved in the project file.

Comments can be added to all selection stages in a project.

- Click Notes in the stage window heading, then enter some comments
- Save the project
  On the File menu, click Save Project. Give the project a filename and directory location; the project will be saved with the file extension .ces.

Exercise 18 — Exporting and Copying

Charts, records, and results lists can be copied and pasted into a document in another application such as Microsoft® Word, Microsoft Excel, Microsoft Powerpoint, or Notepad.

- Copy a chart into a document
  To copy a chart to the clipboard: in the chart window, right-click the chart and select Copy on the shortcut menu, or press CTRL+C.
  You can then paste the chart image from the clipboard into your document.

- Copy a datasheet into a document
  To copy a datasheet to the clipboard: open the datasheet, then right-click the datasheet, and select Copy on the shortcut menu, or press CTRL+C.
  You can then paste the data from the clipboard into your document.

- Copy results into a document
  To copy results to the clipboard, use SHIFT+click or CTRL+click to highlight the records you want, then right-click and select Copy on the shortcut menu, or press CTRL+C.
To select all results in the list, right-click and select Select All on the shortcut menu, or press CTRL+A.
You can then paste the results from the clipboard into your document.

❖ Try editing the document you have created
5 Toolbars and general information

5.1 Standard toolbar

View database homepage  Search the database  Estimate the environmental impact of products  Access learning resources  Change CES EduPack settings

Browse the database tree  Select records using design criteria  Model and predict performance of materials  Search Web and other tools  Open CES EduPack Help

5.2 Chart Stage toolbar

Add an index line  Zoom out  Create curve annotation  Highlight favorites records

Edit stage properties  Delete all lines and boxes  Add text label  Show results from all enabled stages  Highlight user defined records

Select chart records by dragging  Zoom to view all records  Create arrow annotation  Hide failed records  Find records near selected record

5.3 CES EduPack file types

*.gdb  Granta Database file
*.ces  CES Project file
*.cet  Selection Template file
*.frl  Favorites file
*.prd  Eco Audit Product Definition file
## 5.4 Options for Preferred Currency and Units

<table>
<thead>
<tr>
<th>Settings</th>
<th>Database options</th>
<th>Preferred Currency</th>
<th>Preferred Unit System</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;Automatic&gt;</td>
<td></td>
<td>The Regional Setting from the operating system for currency is used to view data. This will appear as: &lt;Automatic - Regional Currency&gt; For example: &lt;Automatic - GBP&gt;.</td>
<td>The Regional setting from the operating system for unit system is used to view data. This will appear as: &lt;Automatic - Regional Units&gt; For example: &lt;Automatic - Metric&gt;.</td>
</tr>
<tr>
<td>&lt;None&gt;</td>
<td></td>
<td>Data is displayed using the same currency as it is stored with in the database.</td>
<td>Numeric data is displayed using the same units as the data is stored with in the database.</td>
</tr>
<tr>
<td>Named setting</td>
<td></td>
<td>Named currency is used to display data.</td>
<td>Named unit system is used to display data.</td>
</tr>
</tbody>
</table>
5.5 Physical Constants and Conversion of Units

Physical Constants

<table>
<thead>
<tr>
<th>Physical Constant</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Absolute zero temperature</td>
<td>-273.2°C</td>
</tr>
<tr>
<td>Acceleration due to gravity, ( \text{g} )</td>
<td>9.807 m/s(^2)</td>
</tr>
<tr>
<td>Avogadro's number ( N_A )</td>
<td>6.022 \times 10^{23}</td>
</tr>
<tr>
<td>Base of natural logarithm, ( e )</td>
<td>2.718</td>
</tr>
<tr>
<td>Boltzmann's constant, ( k_B )</td>
<td>1.381 \times 10^{-23} J/K</td>
</tr>
<tr>
<td>Faraday's constant, ( \text{F} )</td>
<td>9.648 \times 10^{4} C/mol</td>
</tr>
<tr>
<td>Gas constant, ( R )</td>
<td>8.314 J/mol/K</td>
</tr>
<tr>
<td>Plank's constant, ( h )</td>
<td>6.626 \times 10^{-34} J s</td>
</tr>
<tr>
<td>Speed of light in a vacuum, ( \text{c} )</td>
<td>2.998 \times 10^{8} m/s</td>
</tr>
<tr>
<td>Volume of perfect gas at STP</td>
<td>22.41 \times 10^{-3} m(^3)/mol</td>
</tr>
</tbody>
</table>

Conversion of units

<table>
<thead>
<tr>
<th>Unit</th>
<th>Conversion Factor</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Angle, ( \theta )</td>
<td>1 rad</td>
<td>57.30°</td>
</tr>
<tr>
<td>Density, ( \rho )</td>
<td>1 lb/ft(^3)</td>
<td>16.03 kg/m(^3)</td>
</tr>
<tr>
<td>Diffusion coefficient, ( D )</td>
<td>1 cm(^2)/s</td>
<td>1.0 \times 10^{-4} m(^2)/s</td>
</tr>
<tr>
<td>Energy, ( U )</td>
<td>See below</td>
<td></td>
</tr>
<tr>
<td>Force, ( F )</td>
<td>1 kgf</td>
<td>9.807 N</td>
</tr>
<tr>
<td>Density, ( \rho )</td>
<td>1 lbf</td>
<td>4.448 N</td>
</tr>
<tr>
<td>Length, ( l )</td>
<td>1 dyne</td>
<td>1.0 \times 10^{-5} N</td>
</tr>
<tr>
<td>Mass, ( M )</td>
<td>1 ft</td>
<td>304.8 mm</td>
</tr>
<tr>
<td>Density, ( \rho )</td>
<td>1 inch</td>
<td>25.40 mm</td>
</tr>
<tr>
<td>Density, ( \rho )</td>
<td>1 Å</td>
<td>0.1 nm</td>
</tr>
<tr>
<td>Mass, ( M )</td>
<td>1 tonne</td>
<td>1000 kg</td>
</tr>
<tr>
<td>Density, ( \rho )</td>
<td>1 short ton</td>
<td>908 kg</td>
</tr>
<tr>
<td>Density, ( \rho )</td>
<td>1 long ton</td>
<td>1107 kg</td>
</tr>
<tr>
<td>Density, ( \rho )</td>
<td>1 lb mass</td>
<td>0.454 kg</td>
</tr>
<tr>
<td>Power, ( P )</td>
<td>See below</td>
<td></td>
</tr>
<tr>
<td>Stress, ( \sigma )</td>
<td>See below</td>
<td></td>
</tr>
<tr>
<td>Specific Heat, ( \text{Cp} )</td>
<td>1 cal/gal.(^\circ)C</td>
<td>4.188 kJ/kg.(^\circ)C</td>
</tr>
<tr>
<td>Density, ( \rho )</td>
<td>1 Btu/lb.(^\circ)F</td>
<td>4.187 kJ/kg.(^\circ)C</td>
</tr>
<tr>
<td>Stress Intensity, ( K_{1c} )</td>
<td>1 ksi ( \text{\gamma in} )</td>
<td>1.10 MN/m(^{3/2})</td>
</tr>
<tr>
<td>Surface Energy, ( \gamma )</td>
<td>1 erg/cm(^2)</td>
<td>1 mJ/m(^2)</td>
</tr>
<tr>
<td>Temperature, ( T )</td>
<td>1°F</td>
<td>0.556 K</td>
</tr>
<tr>
<td>Thermal Conductivity, ( \lambda )</td>
<td>1 cal/s.cm.(^\circ)C</td>
<td>418.8 W/m.(^\circ)C</td>
</tr>
<tr>
<td>Density, ( \rho )</td>
<td>1 Btu/h.ft.(^\circ)F</td>
<td>1.731 W/m.(^\circ)C</td>
</tr>
<tr>
<td>Volume, ( V )</td>
<td>1 Imperial gal</td>
<td>1.546 \times 10^{-3} m(^3)</td>
</tr>
<tr>
<td>Density, ( \rho )</td>
<td>1 US gal</td>
<td>3.785 \times 10^{-3} m(^3)</td>
</tr>
<tr>
<td>Viscosity, ( \eta )</td>
<td>1 poise</td>
<td>0.1 N.s/m(^2)</td>
</tr>
<tr>
<td>Density, ( \rho )</td>
<td>1 lb ft.s</td>
<td>0.1517 N.s/m(^2)</td>
</tr>
</tbody>
</table>
### Conversion of Units - Stress and Pressure

<table>
<thead>
<tr>
<th></th>
<th>MPa</th>
<th>dyn/cm²</th>
<th>lb/in²</th>
<th>kgf/mm²</th>
<th>bar</th>
<th>long ton/in²</th>
</tr>
</thead>
<tbody>
<tr>
<td>MPa</td>
<td>1</td>
<td>1 x 10⁷</td>
<td>1.45 x 10²</td>
<td>0.102</td>
<td>10</td>
<td>6.48 x 10⁻²</td>
</tr>
<tr>
<td>dyn/cm²</td>
<td>10⁻⁷</td>
<td>1</td>
<td>1.45 x 10⁻⁵</td>
<td>1.02 x 10⁻⁸</td>
<td>10⁶</td>
<td>6.48 x 10⁻⁹</td>
</tr>
<tr>
<td>lb/in²</td>
<td>6.89 x 10⁻³</td>
<td>6.89 x 10⁴</td>
<td>1</td>
<td>703 x 10⁻⁴</td>
<td>6.89 x 10⁻²</td>
<td>4.46 x 10⁻⁴</td>
</tr>
<tr>
<td>kgf/mm²</td>
<td>9.81</td>
<td>9.81 x 10⁷</td>
<td>1.42 x 10³</td>
<td>1</td>
<td>98.1</td>
<td>63.5 x 10⁻²</td>
</tr>
<tr>
<td>bar</td>
<td>0.10</td>
<td>1 x 10⁶</td>
<td>14.48</td>
<td>1.02 x 10⁻²</td>
<td>1</td>
<td>6.48 x 10⁻³</td>
</tr>
<tr>
<td>long ton/in²</td>
<td>15.44</td>
<td>1.54 x 10⁸</td>
<td>2.24 x 10³</td>
<td>1.54</td>
<td>1.54 x 10²</td>
<td>1</td>
</tr>
</tbody>
</table>

### Conversion of Units - Energy

<table>
<thead>
<tr>
<th></th>
<th>J</th>
<th>erg</th>
<th>cal</th>
<th>eV</th>
<th>Btu</th>
<th>ft lbf</th>
</tr>
</thead>
<tbody>
<tr>
<td>J</td>
<td>1</td>
<td>1 x 10⁷</td>
<td>0.239</td>
<td>6.24 x 10⁻¹⁸</td>
<td>9.48 x 10⁻⁴</td>
<td>0.738</td>
</tr>
<tr>
<td>erg</td>
<td>10⁻⁷</td>
<td>1</td>
<td>2.39 x 10⁻⁸</td>
<td>6.24 x 10⁻¹¹</td>
<td>9.48 x 10⁻¹⁰</td>
<td>7.38 x 10⁻⁸</td>
</tr>
<tr>
<td>cal</td>
<td>4.19</td>
<td>4.19 x 10⁷</td>
<td>1</td>
<td>2.61 x 10⁻¹⁹</td>
<td>3.97 x 10⁻³</td>
<td>3.09</td>
</tr>
<tr>
<td>eV</td>
<td>1.60 x 10⁻¹⁹</td>
<td>1.60 x 10⁻¹²</td>
<td>3.38 x 10⁻²⁰</td>
<td>1</td>
<td>1.52 x 10⁻²²</td>
<td>1.18 x 10⁻¹⁹</td>
</tr>
<tr>
<td>Btu</td>
<td>1.06 x 10³</td>
<td>1.06 x 10¹⁰</td>
<td>2.52 x 10²</td>
<td>6.59 x 10²¹</td>
<td>1</td>
<td>7.78 x 10²</td>
</tr>
<tr>
<td>ft lbf</td>
<td>1.36</td>
<td>1.36 x 10⁷</td>
<td>0.324</td>
<td>8.46 x 10⁻¹⁸</td>
<td>1.29 x 10⁻³</td>
<td>1</td>
</tr>
</tbody>
</table>

### Conversion of Units – Power

<table>
<thead>
<tr>
<th></th>
<th>kW (kJ/s)</th>
<th>erg/s</th>
<th>hp</th>
<th>ft lbf/s</th>
</tr>
</thead>
<tbody>
<tr>
<td>kW (kJ/s)</td>
<td>1</td>
<td>10⁻¹⁰</td>
<td>1.34</td>
<td>7.38 x 10²</td>
</tr>
<tr>
<td>erg/s</td>
<td>10⁻¹⁰</td>
<td>1</td>
<td>1.34 x 10⁻¹⁰</td>
<td>7.38 x 10⁻⁸</td>
</tr>
<tr>
<td>hp</td>
<td>7.46 x 10⁻¹</td>
<td>7.46 x 10⁹</td>
<td>1</td>
<td>15.50 x 10²</td>
</tr>
<tr>
<td>ft lbf/s</td>
<td>1.36 x 10⁻³</td>
<td>1.36 x 10⁷</td>
<td>1.82 x 10⁻³</td>
<td>1</td>
</tr>
</tbody>
</table>
6 Legal, acknowledgements, and contact information

Legal and Acknowledgments

License Agreement

CES EduPack is furnished under a License Agreement and may be used or copied only in accordance with the terms of the License.

Trademarks

Cambridge Engineering Selector, CES Constructor, CES EduPack, CES INDEPTH, CES LAB, CES Selector, CES WEB, Eco Audit, Eco Materials Adviser, Granta Design, Granta Material Intelligence, Granta Material Inspiration, GRANTA MI, Hybrid Synthesizer, Synthesizer Tool, Material Universe, Process Universe, the GRANTA, GRANTA Material Intelligence, and GRANTA Material Inspiration logos, the Granta CES EduPack and Granta CES Selector logos are trademarks of Granta Design Ltd.

Microsoft®, Excel®, PowerPoint®, Internet Explorer®, SQL Server®, Windows®, and Windows Server® are registered trademarks of Microsoft Corporation or its subsidiaries in the United States or other countries.

Granta Design Ltd. makes reasonable efforts to explicitly acknowledge all trademarks cited in our literature or on our website. If you would like us to add or alter an acknowledgement, please contact us.

Reproduction

Except as described in the installation instructions, neither the documentation nor the software may be copied, reproduced, translated, or reduced to any electronic medium or machine readable form, in whole or part, without prior written consent of Granta Design Limited.

Teaching Materials

Selection charts, record data, and online teaching resources may be reproduced to be used with students for educational purposes only, as long as Granta Design Limited are referenced as the source and copyright owner or licensor.

To reproduce these in published works you must:

i. gain prior written permission from Granta Design Limited (contact details to be found at www.grantadesign.com/contact).

ii. acknowledge each instance with the following:

bibliographical reference:

Charts/data/etc. from “CES EduPack 2017, Granta Design Limited, UK (www.grantadesign.com)”.

Images - please see the individual image caption for reproduction information of images.
Contact details

If you have any questions, you can contact us at info@grantadesign.com or at one of the phone numbers below.

International Headquarters: Tel: +44 (1)1223 518895
Fax: +44 (0)1223 506432

USA Headquarters Toll-free: 1-800-241-1546
Fax: 1-216-274-9812

France Appellez-nous au numéro vert: 08 00 76 12 90
Fax: 01 53 01 69 66

Germany Tel: 089 921 315 230
Granta für Lehre: 0800 182 5026
Fax: 08005 89431 5000

For further details, see the contact details page of the Granta Design website, www.grantadesign.com.